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3. ITL SOFTWARE SUPPORT GUIDE 
 

3.1 Validator Manager Software 
 

Validator Manager (also called Bank Note Validator Currency Manager) is a software 
package developed by Innovative Technology Ltd to allow customers to carry out 
programming, setup and operational tasks on the NV200 bank note validator. 
 
3.1.1 Preparing for Installation 
 
If you do not have the Validator Manager software on CD, you can easily download it 
from the Innovative Technology website. Visit www.innovative-technology.co.uk, and 
select ‘Software Download’ from the ‘Support’ tab: 
 

 
 
Clicking this link will take you to the software download page. To download any files 
you must log in as a registered user – if you have not already registered this is a very 
quick process; just click the ‘create an account’ link and follow the on-screen 
instructions. 

http://www.innovative-technology.co.uk/
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After logging in, the download screen will change slightly: 
 

Your user name will be displayed in 
the top right hand corner of the 
screen 

 

 

The padlock icon for each file will 
change from locked to unlocked. To 
download a file, just click on the 
padlock icon opposite the file name. 

                

If you want to find more information 
about the file before you download 
it, you can click on the blue 
information icon.   

 

Enter your login 
details here, or 
create a new 
account 
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In this case, we want to download the Validator Manager software, so we click on the 
padlock icon opposite the ‘Bank Note Validator Currency Manager’ filename: 
 

 
 
 
After clicking the link, a file download dialog box will appear – choose the option to 
save the file:  
 
 

 
 
 
You can save the file anywhere that is convenient, as long as you can remember 
where it is when you want to install the software. 
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After choosing where to save the file, a file transfer dialog box will appear showing 
the progress of the file download: 
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3.1.2 BV Interface Drivers 
 
After downloading the Validator Manager software, you will also need to download the 
Banknote Validator (BV) Interface drivers – two versions are available (32 bit and 64 
bit) so choose the correct type for your operating system. Again, remember where 
you saved the file. 
 

 
 
Both files are provided in a ‘zipped’ (compressed) form – you will need to extract the 
files from the zipped file before you can install the software or driver. Any version of 
Windows from Windows 98 onwards can open zipped files; or you may want to use a 
third party software tool such as Winzip or WinRAR. 
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Extract the files to a convenient location – this might be an existing folder, or you may 
want to save them into a new folder. 
 

 
 
In this example, the BV Interface driver files are being saved into a folder called 
‘Drivers’ on the computers C: drive. 
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NV200 Manual Set – Section 3  10 

   

Copyright © Innovative Technology Ltd 2013  GA00620-2 
 

3.1.3 Installing the Drivers  
 
There are several ways to communicate with the NV200 validator, which include using 
a direct connection from computer to validator with a USB cable, or by using a special 
interface unit called a DA2. Use of the DA2 is not covered here – please refer to ITL 
Document number GA338-2 for more information. In this manual we will be using the 
direct USB connection method. 
 
To install the drivers, you need to connect a standard USB 2.0 compliant Type A to 
Type B cable from your computer to the USB interface socket on the rear of the 
NV200 validator: 
 

 

 
 
 
DIP Switches 
 
 
 
 
Interface Connector 
 
 
 
 
 
 
USB Connector 
 
 

 
 
The NV200 validator must be powered up for the interface to be recognised by 
Windows. If the NV200 validator is not in the host machine, you will need to provide 
power to the 16 way interface connector first. The connection information and pin 
numbering is as follows: 
 
 

 
 
 
 
 

Pin Description 

15 + V 

16 0V / Ground Connection  
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Before connecting the USB cable, make sure that the unit is powered up. Once you 
have carried out these steps, plug the USB cable into the NV200 validator. 
 
After connecting the USB cable, Windows 
should then detect the NV200 validator 
interface – a ‘Found New Hardware’ 
bubble or dialog box should appear. 
 
 
 
 
A ‘Found New Hardware’ wizard should then start to guide you through the installation 
process (this first screen is not always shown on some computers): 
 
 

 
 

 
 

   
Information 

Only use V2 drivers 

Please make sure that you are using the V2 drivers 
for the installation. 

 
 

Select this option 
as you already 
have the drivers 
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The next dialog box will ask you where to search for the drivers: 
 
 

 
 
 
 
 
 

Select this option as 
we have saved the 
drivers to a known 
location 

Click the ‘Browse’ 
button to find the 
driver files (in this 
example C:\Drivers) 
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Click the ‘Next’ 
button to install 
the drivers 

Uncheck this option 
to speed up the 
installation 
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You may see a warning dialog saying that the drivers have not passed Windows logo 
testing – you can ignore this warning. Just click the ‘Continue Anyway’ button. 
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Click the ‘Finish’ 
button to complete 
the installation 
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After completing the driver installation you can check that the communications port 
has been installed correctly. 
 
Open Windows Device Manager, and click on the Plus symbol (+) next to the ‘Ports’ 
entry. This will expand the list of installed communications ports. You should see an 
entry for an ‘ITL BV Serial V2’ port as shown here: 
 

 
 
The actual communications port number (in our example COM5) may vary depending 
on your particular computer configuration. 
 
Now the drivers have been correctly installed you can install the Validator Manager 
software – this is covered next. 
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3.1.4 Installing the Validator Manager Software 
 
Installing the Validator Manager software is very straightforward. Find the Validator 
Manager zipped file you downloaded earlier, extract the installation file from the 
zipped file and double click the extracted file (it has an .msi extension) – this will start 
the installation process: 
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You can choose where you would like to install the software, or just accept the default 
location (as shown above). Clicking on the ‘Next’ button will then ask you to confirm 
the installation: 
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Once the installation is complete, you will have a new program group called ‘ITL 
Validator Manager’ in the Windows Start Menu, similar to the one shown here: 
 
 

 
 

You can run the Validator Manager software by clicking the ‘Shortcut to 
ValidatorManager.exe’ menu entry; however, before you can use the Validator 
Manager software with an NV200 validator you will need to make sure that you have 
installed the BV interface drivers (as described earlier). 
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3.1.5 Starting the Validator Manager Software 
 
The Validator Manager software is launched by clicking the ‘Shortcut to 
ValidatorManager.exe’ entry in the ‘ITL Validator Manager’ menu group. 
 

 
 
The initial program screen looks like this: 
 

 
 
Make sure that the NV200 Validator is powered up and the USB cable is connected 
before going any further. All of the program options can be accessed from the menu 
bar at the top of the screen – some specific functions can also be accessed by clicking 
the relevant icon underneath the menu bar, and the function of each icon is indicated 
by a ‘tooltip’ indicator 
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Please be aware that not all the program options are applicable to the NV200, as the 
Validator Manager software is designed to work with a range of ITL Technology 
validators. 

 
Full details of all the Validator Manager software functions are detailed in the program 
help file (accessible from the ‘Help’ menu).  
 
Options: 
 
 
 
The general preferences 
for the Validator 
Manager software are 
accessible from the 
‘Tools’ menu (as 
shown). Click the 
‘Options’ entry to open a 
new dialog box:  
 
 
 
 
 

 
 
 
 
Selecting the ‘Serial Port’ tab from the ‘Options’ dialog and defining which serial port 
to use to connect to the NV200 validator should be one of the first things you do after 
installing the software. 
 
 

These two options are not 
used with the NV200 
validator. 
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The Validator Manager will not work if the serial port is not set or is set incorrectly (if 
the serial port has not been set a dialog box will appear will appear when you run the 
program prompting you to enter or correct the port setting): 
 

 
 
 

 
 
Select the correct serial port from the list and click the ‘OK’ button to confirm the 
setting. 
 

Click this arrow and then click on the 
port you want to select as the default 
from the drop down list. 
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Check Notes: 
 

 
 
 
The ‘Check Notes’ menu item provides a way to check the validator will correctly 
accept bank notes. Clicking the ‘Start-up’ button will initialise the NV200 validator and 
allow acceptance of bank notes. The validator is reset after clicking the ‘Stop’ button. 
 

Enable or disable a 
channel by clicking the 
respective button. 

A summary of 
accepted notes by 
channel 
(denomination) is 
shown here. 

A command and response 
summary is shown here. 
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3.1.6 Preferences, Settings and Options 
 
Options: 
 
The general preferences for 
the Validator Manager 
software are accessible from 
the ‘Tools’ menu (as shown). 
Click the ‘Options’ entry to 
open a new dialog box:  
 
 
 
 
 

 
 
 
 
 
By selecting the ‘Serial Port’ tab from the ‘Options’ dialog you can define which serial 
port is being used to connect to the NV200 validator – click the ‘OK’ button to confirm 
the setting: 
 

 
 

Click this arrow and then click on the 
port you want to select as the default 
from the drop down list. 
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The Validator Manager software can detect the address used by the validator from the 
‘Slave Address’ tab: 
 

 
 
After clicking the ‘Set Program Address’ 
button, a dialog box will appear confirming 
the new setting - click the ‘OK’ button to 
confirm the change. 
 
 
 

   
CAUTION! 

Limited slave address 
ranges 

 

The Validator Manager software will only 
communicate with the validator if the slave address 
is set to 0, 1 or in the range 80-99. 

 
 
The ‘ccTalk Key’ tab allows the user to enter a six digit security key for use when the 
validator is set for ccTalk operation. 
 

Click this button to allow 
the Validator Manager 
software to interrogate the 
attached validator and 
determine the currently 
set slave address. 

Click this button to cancel 
finding the slave address. 

Click this button to set the 
slave address. 
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The ccTalk key is the HOST key, and is used for the ccTalk check – the validator must 
be configured to use the same key. 
 

   
CAUTION! 

Take care when changing 
ccTalk key 

 

The user should make a note of the new key and 
after any change. The default setting for the ccTalk 
security key is 123456. 

 
 
Select the ‘Language’ tab to change the preferred language for the software. You 
shouldn’t normally need to change the language setting, as this is determined 
automatically based on the Windows locale settings. You can if you wish select one of 
five specific languages (German, English, Spanish, Portuguese or Russian) if needed, 
as shown below. 
 
Click the ‘OK’ button to confirm the change – you will have to close and reopen the 
software to allow the language change to take effect. 
 
 
 
 

Enter the 6 digit key in this 
box, and then click the 
‘OK’ key to confirm. 
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The final tab on the ‘Options’ dialog is the ‘eSSP Key’ tab. By selecting this tab you 
can set a new security key to use when the validator is operating in SSP mode. 
 
 

   
CAUTION! 

Take care when changing 
eSSP key 

 

Exercise care when changing the device eSSP key. 
The user must make a note of the new key and 
change the host key to match. If the key is not 
known then device must be returned to ITL for key 
reset. 

This is the default setting and 
will not normally need changing. 
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After entering a new key, press the ‘OK’ button to confirm the change. 
 
Validator Options: 
 
NV200 validator specific options are accessed from the ‘Set Validator Options’ item on 
the ‘Tools’ menu: 
 

 
 

Enter the new hex security 
key in these boxes, and 
then click the ‘OK’ key to 
confirm. 
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As with the ‘Options’ dialog, the ‘Set Validator Options’ dialog also has several tabs: 
 

 
 
The first tab ‘Target Details’ allow you to see specific details about the validator, and 
provides a simple way of checking what version of firmware or dataset are currently 
installed: 
 

 
There are no user-changeable settings on this tab. 
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The second tab ‘Dataset Settings’ allows you to review and modify the settings of 
each installed channel: 
 

 
 
Right clicking on a channel will open a further dialog allowing you to make specific 
changes: 
 

 
 

Consult the Validator Manager software help file for more information on how to 
change channel settings. 
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The third tab ‘ccTalk Settings’ allows you to review and modify the ccTalk settings and 
also change the security key settings: 
 

 
 

   
CAUTION! 

Take care when changing 
ccTalk key 

 

The user should make a note of the new key and 
after any change. The default setting for the ccTalk 
security key is 123456. 

 
 
The fourth tab ‘MDB Settings’ allows you to review and modify specific settings if the 
validator is being used with the MDB protocol: 
 

 
 
 

Check this box to allow 
setting of a new user key. 

Enter the new 6 digit 
user key in this box. 
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The fifth tab ‘General Options’ allows you to review and modify a variety of validator 
specific settings, including interface mode: 
 
 
 
 

 
 
 
 
 
 

   
WARNING! 

Security risk 

 

Disabling the Strim Function is not recommended 
because of the potential security risks. 

 
 

   
Information 

Limited SSP address 
ranges 

The Validator Manager software will only 
communicate with the validator if the SSP address is 
set to 0, 1 or in the range 80-99. 

 

Check the box next to the interface mode 
you want the validator to operate in. 

Click this box to enable or 
disable the Strim Function. 

These pulse timing settings are 
only used if the validator is set 
to operate in Pulse mode. 

Click this box to enable or 
disable the PIN lock function 
for the memory card. 

Specify the SSP address used by 
the validator in this box. 

Specific channels 
(denominations) can be disabled 
by checking the appropriate box 
or boxes. 

The options shown in this area 
will vary depending on the 
interface type selected. 
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The final tab, ‘Update Changes’ commits all the changes to the validator configuration 
and updates the validator accordingly: 
 
 

 
 
 
 

   
Information 

Always apply changes 

Please make sure that you click the ‘Apply Changes’ 
button, otherwise none of your configuration 
changes will be applied or saved. 

 

Click this button to apply 
all the changes and 
update the validator. 

This status bar indicates 
the progress of the update 
process. 

This message indicates the 
interface type being 
applied. 
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After applying the changes successfully, a dialog box will 
appear confirming the operation - click the ‘OK’ button to 
confirm this and close the dialog box. The validator will 
then be reset.  
 
 
 
 
NV200 Bezel: 
 
The ‘NV200 Bezel’ menu item allows you to change the bezel illumination to suit your 
specific requirements: 
 

 
 
Click the ‘Apply Changes’ button to update the validator settings, or click the ‘Cancel’ 
button to exit without making changes. 
 
 

   
WARNING! 

Do not power off or 
disconnect 

 

Powering off the NV200 or disconnecting the USB 
cable when updating settings can cause the 
validator to stop working. 
 

Indicates the colour 
that has been 
selected 

Allow you to choose 
whether the bezel 
lights flash or are 
always on. 

Move the sliders to 
change the intensity 
of each colour. 
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eSSP Options: 
 
The ‘eSSP Options’ menu item allows the user to change the fixed part of the SSP key 
and other functions. Selecting this menu option will open a dialog box like this: 
 
 
 
 
 

 
 
 
 
After carrying out any of the operations on this dialog, the validator will be reset. Click 
the ‘Exit’ button to close the dialog. 
 
 

 

Click this button to disable SSP 
encryption in the validator. 

 

Click this button to enable SSP 
encryption in the validator. 

 

Click this button to change the 
validator eSSP key. 

 

Enter the new eSSP 
key in these boxes. 
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3.2  Updating Firmware and Datasets 

 

   
CAUTION! 

Do not power off 

 

Powering off the NV200 when updating the 
firmware or dataset can cause the validator to stop 
working. 
 

 
The NV200 validator firmware and dataset can be updated very easily using the 
Validator Manager software. The dataset files can be downloaded from the Innovative 
Technology Ltd website: 
 

 
 
 
 

   
Information 

Combined data files 

The firmware and dataset files for the NV200 
validator are combined into a single file, so both will 
be updated when you carry out the update. 
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After selecting the dataset, a dialog will prompt you to save or open the file: select 
the Save option 
 
  

 
 
You can then choose where to save the file – choose a location that is convenient for 
you: 
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Once the dataset file is saved, unzip the file and you can then start the process to 
update the NV200 validator by connecting the USB cable and starting the Validator 
Manager software as described previously.  
 
 
 
From the Validator 
Manager main screen, 
select the ‘Open a 
BV/NV200 file’ entry 
from the ‘File’ menu as 
shown here: 
 
 
 
 
 
 
 
You will then be prompted to select the dataset file you downloaded and unzipped 
earlier – select the file and click the ‘Open’ button: 
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After clicking the ‘Open’ button, a new dialog box will appear. The status bar in the 
bottom left hand corner of the dialog box will show the progress in loading the 
dataset: 
 

 
 
Once the dataset has been loaded, the file details will be shown in the status window, 
and the two buttons at the bottom of the dialog box will be active - make sure that 
you do not disconnect the power to the NV200 or the USB cable until the 
programming operation has been completed. Click the ‘Program’ button to start 
the update process: 
 

 
 



NV200 Manual Set – Section 3  40 

   

Copyright © Innovative Technology Ltd 2013  GA00620-2 
 

 
During the update process, the progress of the update will be shown in the status bar 
at the bottom left of the dialog box, and the mouse cursor will change to an 
hourglass: 
 

 
 
While the update process is being carried out, the NV200 bezel will turn blue and flash 
on and off until the update is completed. After the update, the NV200 will be reset, 
and the dialog box will then look like this: 
 

 
 
After the reset is complete, the NV200 validator will then be ready for use with the 
new currency.  
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It is also possible to update the NV200 validator by 
using the memory card slot on the front of the 
validator (shown in the picture on the right): 
 
 
 
 
 
 
 
 

   
Information 

Only use 8mb Atmel Data 
Cards 

Only Atmel 8MB DataFlash® cards can be used (ITL 
part number IC00237). Standard SD memory 
cards will not function. 

 
The memory card will need preparing using a DA3 Programming Unit and the NV 
Memory Card Utilities software - this procedure is documented in ITL Document 
number GA00796 – NV Card Utilities. 
 

   
CAUTION! 

Check DA3 firmware 
version. 

 

If using a DA3 and memory card to update the 
NV200 validator, the DA3 firmware should be up-
to-date (check the ITL website for the latest 
version). Using older versions of the DA3 firmware 
can corrupt the validator. 
 

 

Once the memory card has been programmed with the required information, the 
validator is re-programmed by simply inserting the card into the NV200’s memory card 
slot – make sure that the NV200 validator is powered up before inserting the card. 
 

   
CAUTION! 

Do not disconnect power. 

 

Do not disconnect the power or data connection 
from the NV200 at this point. Doing so could cause 
the unit to become un-usable. 

 

Once the NV200 is successfully updated the validator will be reset and will then be 
ready for use with the new currency – at this point you can remove the memory card 
from the slot. 
 
 

Memory 
card slot 
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3.3 Tools 
 
3.3.1 Diagnostics 
 
There is a dedicated software diagnostics tool for use with the NV200 validator called 
‘Bank Note Validator Diagnostics Tools’, and this software can be downloaded from 
the Innovative Technology Ltd website: 
 

 
 
When the file download dialog box appears, click the ‘Save’ button and select a 
suitable location to save the file in: 
 

 
 
Installing the Diagnostics tools software is done in the same way as the Validator 
Manager software - Find the ITLDiagnosticsTools zipped file you just downloaded, 
extract the installation file from the zipped file and double click the extracted file (it 
has an .msi extension) – this will start the installation process. 
 
 
 
 



NV200 Manual Set – Section 3  43 

   

Copyright © Innovative Technology Ltd 2013  GA00620-2 
 

 
 
 
After installing the software, you can run the 
diagnostics software by selecting the 
‘Shortcut to ITL Diagnostics.exe’ item near 
the top of the Windows Start menu. Make 
sure that the NV200 Validator is powered up 
and the USB cable is connected before 
starting the program. 
 
 
 
 
 
The main screen of the diagnostics tools software looks like this:  
 

 
 
When running the software for the first time, you need to set a few options. These 
are accessed from the ‘Options’ menu: 
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By selecting the ‘Serial Port’ item 
from the ‘Options’ menu you can 
define which serial port is being 
used to connect to the NV200 
validator. After selecting this 
option, a new dialog box will open 
allowing you to choose the correct 
serial port. 
 

 
 
Select the required port from the dropdown list, 
and then click the ‘OK’ button to confirm your 
selection. This will close the dialog box and allow 
you to select another option from the menu. You 
shouldn’t normally need to change the language 
setting, as this is determined by the Windows 
locale settings. You can if you wish select one of 
four specific languages if needed, as shown 
below:  
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Select the ‘Diagnostics’ item from 
the ‘Utilities’ menu to start the 
diagnostics process (you can also 
start the diagnostics by clicking 
on the left hand icon below the 
menu bar) - this will open the 
Diagnostics screen: 
 
 

 

 
 
Click the ‘Start Diagnostic’ button to start the diagnostic process. The software will 
then prompt you to insert a special piece of green diagnostics paper (ITL part number 
LB149). Insert the paper in the same way you would with a bank note – at the end of 
the diagnostics test the paper will be ejected. 
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Diagnostics Pass: 
 
 
 
 
 

 
 
 

Sensor test results are shown in 
this window. 

Motor test results are shown in 
this window. 

A summary of the validator type and 
related information is displayed here. 

The overall test result is displayed here. 
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Diagnostics Fail: 
 
 
 
 
 

 
 
 
 
 
 
 
 
Further details on how to use the diagnostics tools and interpret the results can be 
found in the program help file. 

Motor test results are shown in 
this window – in this example all 
the motors have passed testing. 

Sensor test results are shown in this 
window – in this example, all sensors have 
passed the testing except for the ‘Note 
Straight 200’ sensor which has failed. 

A summary of the validator type and 
related information is displayed here. 

The overall test result is displayed here. 
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3.3.2 Connections 
 
The NV200 validator has two connectors that are used to allow interfacing and 
programming; these connectors are easily accessible on the back of the validator. 
 
 

   
Information 

Power always required 
regardless of connection 
type. 

Power is always required on pins 15 and 16 of the 
16 way connector. 

 
The first connector is a 16 pin socket used to interface the NV200 to the machine it is 
being installed in. The pin numbering of the socket is shown here, as well as an 
overview of the socket connections: 
 
 
 
 
 
 
 
The USB connector is a standard Type ‘B’ USB socket, and can be 
used for interfacing to the host machine; in this case, power must 
be provided from the 16 way connector. This socket can also be 
used for programming and serial communications – a USB 2.0 
compliant Type ‘A’ to ‘B’ lead can be used to do this. USB cables 
should be electrically shielded and less than 5 metres long. 
 
The function of pins 1 - 9 can change depending on which machine interface is being 
used with the NV200. Typically, the validator will be using SSP, ccTalk or SIO 
interfaces. MDB, Parallel, Binary and Pulse interfaces are only supported with the use 
of an external interface, so there are no connection tables shown here – please 
contact ITL Sales or Support for further details. 
 
The socket connections for the SSP and ccTalk interfaces are shown in the tables 
below, as is a summary of the interface units needed for other types of operation:

Pin Description 

6 Serial Data Out (Tx) 

7 Serial Data In (Rx) 

15 + V 

16 0V / Ground Connection 
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NV 200 SSP Interface: 
 

Pin Name Type Description 

1 TxD Output TTL TxD  

2 TxD Opto Emitter Output Opto isolated TxD Emitter 

3 RxD Opto + Input Opto RxD + 

4 RxD Opto - Input Opto RxD – 

5 RxD Input TTL RxD 

6 TxD RS232 Output RS232 TxD 

7 RxD RS232 Input RS232 RxD 

8 Factory use only Do not connect 

9 TxD Opto Collector Output Opto Isolated TxD Collector 

10 

Factory use only Do not connect 

11 

12 

13 

14 

15 V In Input +V 

16 GND Input GND 

 
NV200 ccTalk Interface: 
 

Pin Name Type Description 

1 TxD Output TTL TxD – connect to pin 5 

2 

Factory use only Do not connect 3 

4 

5 RxD Input TTL RxD – connect to pin 1 

6 

Factory use only Do not connect 

7 

8 

9 

10 

11 

12 

13 

14 

15 V In Input +V 

16 GND Input GND 
 

 

   
WARNING! 

Risk of unit damage 

Do not make any connections to the interface socket 
pins marked ‘Do not connect’ – making connections 
to these pins could cause severe damage to the unit. 
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Multi Drop Bus (MDB) Interface: 
 
MDB is a serial bus interface commonly used in electrically controlled vending 
machines. This is a 9600 Baud Master – Slave system where the NV200 validator is a 
slave to master controller. 
 
To use the NV200 with MDB protocol, an IF5 external interface is required. The IF5 
regulates the power supply and opto-isolates the communication lines. The NV200 
validator supports the MDB Protocol Version 1, Level 1. 
 
Parallel Interface: 
 
To use the NV200 in Parallel mode, an IF10 external interface is required. When 
operating in Parallel mode the NV200 will issue a 100ms active LOW pulse on the 
relevant vend line, and a maximum of 4 channels can be used. 
 
Binary Interface: 
 
To use the NV200 in Binary mode, an IF9 external interface is required. When 
operating in Binary mode the NV200 will issue a binary pattern on vend lines 1 to 4, 
and a maximum of 15 channels can be used. 
 
Pulse Interface: 
 
To use the NV200 in Pulse mode, an IF15 external interface is required. When 
operating in Pulse mode the NV200 outputs a number of pulses on Vend 1. The 
number of pulses for each channel is different and set to default values within the 
dataset. The number of pulses and the pulse duration can be modified using the Bank 
Note Validator Currency Manager Software, and a maximum of 16 channels can be 
used. 
 
Opto-isolation and RS232 communications is only 
available on validators with an issue number of 4 or 
greater. You can check the issue number on the 
validator as shown here: 
 
Open the NV200 validator lid and check the marking 
on the  PCB where shown in this picture – the 
marking needs to read PB00266_4 

 
If the issue number is less than 4 or not visible, 
contact ITL Support for connection options and 
information. 
  

 
 

PCB 
marking 
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3.4 Frequently Asked Questions 
 
a. What settings should I use on the DIP switches on the rear of the unit? 
 

 Look at the DIP switch tables in Section 1 of this manual set (subsection 1.3)  

 
b. Are 64 bit drivers available? 
 

 Both 32 and 64 bit drivers can be downloaded from the ‘Support’ section of the 
ITL website – please make sure that you are using the correct type of driver for 
your Operating System. 
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